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1 What is LIMP? 
 

LIMP is a program for the measurement of loudspeaker impedance and estimation of the 

loudspeaker’s physical and dynamical parameters (also called Thiele-Small parameters). It is also a 

general-purpose program for measuring impedance in the audio range.  

  

Requirements to use LIMP are: 

o Operating systems: Windows Vista / 7 / 8 / 10 /11 

o Processor class Pentium, clock frequency 1 GHz or higher, 2GB memory for 32bit or 4GB for 

64bit Windows  

o Full duplex soundcard with synchronous clock for AD and DA converters  

o WDM or ASIO soundcard driver (ASIO is trademark and software of Steinberg Media 

Technologies GmbH). 

  

The installation of LIMP is through a common setup program for the ARTA Software. 

All Windows registry data for LIMP will be automatically saved at first program execution, and files 

with extension ".LIM" will be registered to be opened with a program LIMP.   

Results of measurement can also be saved as ASCII formatted files in .ZMA format.  

LIMP does not dump graphs to the printer, instead, all graphs can be copied to the Windows Clipboard 

and pasted to other Windows applications or saved to files in .BMP, .PNG or .JPG formats.  
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2 Impedance Measurement Theory 
 

2.1 Basic Circuit for Impedance Measurement 
The measurement of the loudspeaker impedance is based on the system shown in Fig. 2.1. The 

reference resistor R is connected between the signal generator and a loudspeaker impedance Z.  

 

 

 

Figure 2.1 A circuit for loudspeaker impedance measurement 

 

Impedance is defined in the frequency domain as Z (f ). In Fig. 2.1 we denote U1 (f )  as reference 

voltage on generator output and U2 (f ) as voltage on measured impedance. These voltages define 

current that flow through reference resistor R as  (U1 (f ) – U2 (f ) ) / R , and  we can estimate the 

impedance using expression: 
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2.2 Stepped Sine and FFT mode of measurements 
 

LIMP has two modes of impedance measurement: 

1) Stepped sine mode 

2) FFT mode with multitone or pink periodic noise (Pink PN) excitation 

In the stepped sine mode LIMP generates a pure sinusoidal signal, frequency by frequency with 1/24 

or 1/48 octave increment, and measures response to sinusoidal signal by filtering out noise and 

distortion components in sinusoidal response. It is the preferred mode for impedance measurement, 

but the measurement time is very long.  

FFT mode is a faster method for impedance measurement, but it gives a much lower measurement S/N 

ratio than in stepped sine mode.  In FFT mode LIMP simultaneously measures the values of the 

impedance in the whole audio range of frequencies. It allows for two kind of wideband excitation 

signals: multitone or wideband pink PN.  

The wideband pink PN and multitone signals are realized as periodic random phase multi-sine signals. 

Both are a zero dc, periodic signals that contain N sine components, each with a random phase:  
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The pink PN has frequency components on all the FFT frequency bins (fk = k fs/N) and its spectral 

magnitudes roll-off at -3 dB/octave (Ak =√2A2k ) after specified cut-off frequency.  

In LIMP, a variable low frequency cut-off frequency can be changed in the 'Signal Generator Setup' 

dialog box. The pink noise is usually used with a cut-off frequency set close to the frequency where 

the loudspeaker has an impedance maximum (20-100 Hz). The pink PN signal has the statistical 

distribution close to the normal distribution.  

Multitone signal, as defined in the IEC 60268-21 standard, is the sum of random phase spectral 

components that have equal magnitude (Ak =const.), but they are sparsely generated only on FFT 

frequency bins that are approximately 1/n-octave apart (fk+1 = fk 21/n). In Limp the resolution of 1/24 

octave is used if FFT size is less than 64K, otherwise the resolution is 1/48 octave.   

Although multitone and pink PN are mathematically similar signal, they sound very different and are 

used for different purposes. Pink PN is always generated as a wideband signal while the multitone 

spectrum can be user defined in a restricted frequency range [Fstart, Fstop].    

In LIMP multitone and pink PN signals are generated with a crest factor slightly larger than 12 dB.  

The sine signal has crest factor 3 dB. Signals generated using D/A converters have limited peak signal 

value, which means that maximal total RMS value of all multitone components is about three time 

smaller (9 dB) than maximal RMS of sine signal (for the same peak value). If we generate multitone 

with resolution of 1/48-octave it means that in audio range there will be 480 multitone components 

each with RMS value that is sqrt(480) times lower than multitone total RMS, or 3*sqrt(480) lower 

than sine rms value. This reasoning leads us to the conclusion that measurement in stepped sine 

mode theoretically has 36 dB better S/N ratio.  

 

2.3 Simple Measurement Procedure 
 

In Stepped sine mode, a simple measurement procedure is as follows: 

1. LIMP generates a pure sine signal starting with f = Fstart. We assume that this is output signal 

of the generator shown in Fig. 2.1.  

2. After an arbitrary transient time, that is necessary to reach the steady state, voltages at both 

ends of the reference resistor are measured as discrete time series u1 and u2 of length N.   

3. The magnitude and phase of signal u1 and u2 at frequency f are estimated by finding 

fundamental sinusoidal components U1 and U2 at generator frequency f. It is done by directly 

solving Fourier integral in integration time T. These fundamental harmonics are used in the 

equation (1) to calculate the impedance Z.  

4. After some arbitrary time, we call it intra burst pause, that is necessary for measured system 

to release reactive energy, a frequency is incremented for 1/24 octave (or 1/48 octave) and the 

process is being repeated from step 1) until the predefined stop frequency is reached.  

   

 In FFT mode, a simple measurement procedure is as follows: 

1. LIMP generates the Pink PN or multitone as a discrete periodic sequence with a period equal 

to N. We assume that this sequence drives the generator shown in Fig. 2.1.  
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2. After one pre-averaging cycle, which is necessary to reach the steady state, voltages at both 

ends of the reference resistor are measured as discrete time series u1 and u2 of length N.   

3. The DFT is applied to time series u1 and u2 to get spectral components U1 (f) and U2(f). They 

are used in the equation (1) to calculate the impedance Z(f).  

 

2.4 Measurement in a Noisy Environment 
The main source of measurement noise is a loudspeaker that acts as a microphone for the 

environmental noise and vibrations.  

Loudspeaker generated noise depends on three sources:  

• First source is airborne noise that activate loudspeaker to work as microphone.  

• Second source of noise is external mechanical vibration that moves loudspeaker and modulate 

membrane position – again we have microphonic effect.   

• Third source of noise is self-vibration of loudspeaker that exists when loudspeaker is driven by 

large signal. This kind of noise is very strong if loudspeaker is loosely mounted, then vibration 

of basket and magnet nonlinearly interact with mounting body.  

To get reliable results, particularly in FFT mode, measurement should be done in low noise 

environment, with loudspeaker firmly decoupled from vibrational sources. Also, it is beneficial to 

orientate membrane vertically, as it reduces gravitational force influence on membrane displacement. 

Fig. 2.2 shows modified circuit for the loudspeaker impedance measurement, with the noise generator 

En included. 

 

 

 

Figure 2.2 A circuit for the loudspeaker impedance measurement, with the noise generator En 

 

If we apply equations for impedance measurement (1) to this circuit, we get the estimated impedance 

value: 
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What this equation shows is that estimated impedance differs from the true impedance Z by 

the term that is dependent on the S/N ratio (Eg/En) and values of resistors R, Rg and the 

impedance Z. By using additional knowledge from measurement process we can conclude: 
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1. The simple theory shows that the signal generator must supply a high voltage, to assure high 

S/N, but practical measurements have shown that it is better to use smaller output voltage. 

Two facts prove that. First, a larger voltage drives the loudspeaker to highly nonlinear region. 

Second, a larger voltage drive can enlarge driver self-vibration that can produce discontinuous 

noise in interaction with mounting. AES recommends voltages in the range 0.1 – 0.2 V, but 

even lower values are acceptable. This is especially important if we measure impedance to get 

data for driver parameters estimation. 

2. When we use the FFT method the measurement results are highly affected with noise. The 

loudspeaker acts as a microphone with a highest sensitivity in the region of the membrane 

resonance. It means the highest level of the noise is at low frequencies, so we must generate 

the signal with high level at low frequencies, i.e. the pink noise, or multitone with spectral 

components equally distributed on log-frequency scale. 

3. Values of resistors R and Rg must be small, an optimum being a value close to the magnitude 

of the measured impedance. Practically, we can use R = 10-27 ohm to get a very good 

impedance estimation, but then we need a power amplifier to supply large current.  If we use 

the soundcard headphone output as a signal generator, then we can use R = 40-100 ohms. If 

we use the soundcard line output as a signal generator, due to the limited current capability, 

we must use R>600 ohms. In that case we can't get a good estimation with FFT method, but 

we still can successfully use the stepped sine method.  

 
2.4.1 Lowering Measurement Noise in Stepped Sine Mode 

In stepped sine mode LIMP uses the "heterodyned" principle to filter all spectral components 

that are out of the passband which is centered at the measured frequency. The bandwidth of 

the filter is equal to 1/T where T is integration time of the Fourier integral. For example, if we 

use an integration time of 200ms, then the width of the passband of the "heterodyne" filter is 5 

Hz. 

2.4.2 Lowering Measurement Noise in FFT Mode  

In FFT mode the noise can be partly lowered by using the averaging technique in the 

estimation of U1 and U2. LIMP averages the auto-spectrum of U1 and the cross-spectrum of U1 

and U2, giving the following estimated impedance: 
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Note: brackets <> denotes averaged values and star denotes the conjugate complex value. 

 

Two types of averaging can be applied in LIMP. 

• time domain synchronous averaging 

• frequency domain asynchronous averaging 

 In a "time domain synchronous averaging" LIMP generates multiple periods of one noise sequence 

(Fig. 2.3).  

In a "frequency domain asynchronous averaging" LIMP generates a different noise sequence for every 

acquired FFT block (Fig. 2.4). The Frequency Domain Asynchronous Averaging can give slightly 
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better results than the synchronous averaging in systems with nonlinear distortion, but it needs longer 

time for measurements.  

 

 

 

Figure 2.3 Signal generation and acquisition during the synchronous time domain averaging process 

 

 

Figure 2.4 Signal generation and acquisition during the asynchronous frequency domain averaging  
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3. Hardware Setup  
 

The simplest measurement configuration is shown in Fig. 3.1.  The soundcard phone-out (headphone 

output) is used as a signal generator output. The soundcard right line-input is used for recording the 

reference voltage U1 and the soundcard left line-input is used for recording the voltage U2.    

If the soundcard has no headphone output, then we have to connect an external power amplifier to the 

soundcard line-out output, as shown in Fig. 3.2.  

 

 

 

 

 

 

 

Figure 3.1 Measurement setup 

for loudspeaker impedance 

measurements, using the 

headphone output 
 

 

 

 

 

 

 

Figure 3.2 General 

measurement setup for 

loudspeaker impedance 

measurements 
 

 

To protect the soundcard input from a large voltage that may be generated at a power amplifier output, 

it is recommended to use the voltage probe circuit with Zener diodes, as shown on Fig. 3.3. Values of 

resistors R1 and R2 have to be chosen for arbitrary attenuation (i.e. R1=8200 and R2=910 ohms give 

probe with -20.7 dB (0.0923) attenuation if the soundcard has usual input impedance – 10 kΩ).   

 

 

Figure 3.3 Voltage probe with 

the soundcard input channel 

overload protection 
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4 Working with LIMP 
 

When you start LIMP you get the program window shown in Fig. 4.1. There are: menu bar, toolbar 

and a dialog bar at the top of the window and a status bar on the bottom of the window.  The central 

part of the window will show the magnitude and the phase plot.   

 

 

 

Figure 4.1 Main program window 

 

 

Figure 4.2 Toolbar icons 

 

 



  LIMP User Manual 

11 

 

 

 

 

 

 

Figure 4.3 Status bar shows the peak level (ref. full scale) of left and right line inputs  

 

 

 

 

 

 

 

Figure 4.4 Top and right dialog bars 

 

 

Images of graphs and windows can be copied to Windows clipboard or saved to the file in a three 

image formats: png, bmp and jpg. It is recommended to use png format. 

Obtaining a copy of the full window picture is simple. User needs to simultaneously press keys 

Ctrl+P. After that command the window picture will be saved in the System Clipboard, from there the 

user can paste it in other open Windows applications (MS Word, MS Paint). Keys Ctrl+Alt+P 

activate command to save that image in the file. 
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To copy or save the graph picture, that is shown inside the window, user needs to simultaneously press 

keys Ctrl+C or activate the menu command 'Edit->Copy', or press appropriate 'Copy' button.  In the 

main window toolbar, the 'Copy' button is shown as toolbar icon .  

The Copy command opens the dialog box 'Copy/Save Image with Extended Information', shown in 

Figure 4.5. Here user has to setup following options: 

 

1) By using the combo box above ‘OK’ button, user chooses one of three modes of 

saving the image: Copy to Clipboard, Save to File and Save to File + Copy to 

Clipboard. 

2) In the Edit box user optionally enters the text that will be appended at the bottom of 

the graph.  

3) Check box ' Add filename and date' enables adding text to the graph that shows file 

name, date and time. 

4) Check box 'Save text' enables saving entered text for the next copy operation.  

5) Combo box ‘Aspect ratio’ – sets aspect ratio for copying graphs with fixed width. 

6) Bitmap size is chosen by selecting one of following combo box items: 

▪ Current screen size - variable width and height option  

▪ Smallest - fixed graph width 500 points  

▪ Small - fixed graph width 600 points  

▪ Medium - fixed graph width 800 points  

▪ Large - fixed graph width 1000 points  

▪ X Large - fixed graph width 1200 points  

▪ XX Large - fixed graph width 1500 points  

▪ XXX Large - fixed graph width 2000 points  

 

The button 'OK' copies the graph to the system clipboard or opens dialog to enter name of file in 

which picture will be saved. 

The button 'Cancel' cancels the copy operation. 

 

 

  

Figure 4.5 Dialog box 'Copy / Save with Extended Information' 
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4.1 LIMP Menus 
 

Here is a brief explanation of LIMP menus: 

File   

       New - initializes a new file content 
       Open...  -  opens an existing impedance file (*.LIM) 
       Save - saves the file with a current name 
       Save As... -  saves the file under a new name 
       Info. -  shows information about current file 
       Export ASCII - exports the file content in a textual - ASCII file 

Commented .TXT file - exports textual file with comment and rows containing frequency, 

impedance magnitude and phase 
Plain .ZMA file - exports textual file with rows containing values of frequency, impedance 

magnitude and phase 

CSV (Excel) file - exports CSV file containing frequency, impedance magnitude and phase 

       Import from .txt or .zma file – imports impedance data from a textual file whose rows contain    

       values of frequency, impedance magnitude and phase 

       Recent File - opens a recently opened file 
       Exit   -   exits the program 

 

Overlay 

        Set as overlay- sets the current impedance curve as an overlay 
        Delete - deletes overlay 
        Load - loads an overlay from an impedance file 

        Set as target curve - sets current curve as target curve 

        Load target curve - loads an target curve from an impedance .lim or .zma file 
        Delete target curves - deletes all target curves 

        Make target curve from TSP – makes and shows target impedance curve calculated from  

        measured loudspeaker parameters 

 
 

Edit  

        Copy - copies the graph and user defined text to the clipboard or saves that image to the file  

        Setup colors and grid style - sets graph colors and grid style 

        B/W background color - changes the background color to black or white 
        Thick pen - uses thick pen for plotting curves 

        Thick grid - uses thick pen for plotting grids 

        Subtract overlay - subtracts overlay impedance from current impedance 

        Add overlay - add overlay impedance to current impedance 
 

View 

        Toolbar - shows or hides the Toolbar 
        Status Bar - shows or hides the Status bar 
        Fit graph range - changes graph top margin to show full impedance curve 
        Magnitude - shows only impedance magnitude curve 
        Magnitude+phase - shows impedance magnitude and phase curves 

 

Record  
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        Start - starts recording (measurement) 
        Stop - stops recording (measurement) 
        Calibrate - opens the dialog box for calibration of line input channels  

 

Setup                                 

        Audio devices - sets current input and output devices         
        Generator and Input Monitor - sets generator parameters and measures input voltages 
        Measurement - sets measurement parameters 

        Cable compensation - sets resistance and inductance for cable impedance compensation 

        Graph - sets graph margins 

        CSV format - opens dialog box for setup of decimal separator character in CSV files 

 

Analyze   

Loudspeaker parameters - Closed box method - shows the dialog box for the estimation of 

loudspeaker parameters using Closed box method      

Loudspeaker parameters - Added mass method - shows the dialog box for the estimation of 

loudspeaker parameters using Added mass method      

Loudspeaker parameters - Fixed mass method - shows the dialog box for the estimation of 

loudspeaker parameters using Fixed mass method      
RLC impedance values at cursor position - estimate values of impedance serial RLC elements 

 

Help  

        About - gets information about LIMP 
        Registration - shows the user license registration 
        User Manual - shows the help file 

 

 

Useful keyboard shortcut keys are: 

Up and Down keys - change the top graph margin 
Left and Right keys - move the cursor left and right 

Ctrl+S key - saves the file 
Ctrl+N key - makes a new file 
Ctrl+O key - opens the file 

Ctrl+C key - copies the graph and user defined text to the clipboard or saves that image to the file 
Ctrl+P key - copies a whole window bitmap to the clipboard 

Ctrl+Alt+P key - saves a whole window bitmap to the file 
Ctrl+B key - changes background color 

F3 key - make target curve by calculating loudspeaker impedance using current TSP parameters 
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4.2 Soundcard Setup 
 

Activate the menu Setup->AudioDevices. You will get the 'Soundcard Setup' dialog box shown in 

Fig. 4.6. In this dialog box you choose which soundcard will be used as an input or output device. 

Generally, choose the same card as an input and output device.  

 

 

 

 

Figure 4.6 Soundcard setup 

 

The 'Audio Device Setup' dialog box has following controls: 

Soundcard driver - chooses the type of soundcard driver (WDM – windows multimedia driver 

or one of installed ASIO drivers).   

Input channels - chooses the soundcard input stereo channels. ASIO driver can have large 

number of channels. 

Output Device - chooses the soundcard output stereo channels.  

Generally, user chooses input and output channels of the same soundcard (mandatory in ASIO 

driver mode).  

Control panel button – if WDM driver is chosen, it opens Sound control panel. If ASIO driver 

is chosen, it opens ASIO control panel. 

Wave format – chooses Windows wave format: 16-bit, 24-bit, 32-bit or Float.  Float means 

IEEE floating point single precision 32-bit format. It is recommended to use 24-bit or 32-bit 

modes when using a high quality soundcard (many soundcards are declared as 24-bit, but their 

real bit-resolution is less than 16-bits).  It is recommended to choose resolution type Float. This 

control has no effect in the ASIO mode, where a bit resolution has to be setup in the ASIO 

control panel. 

 

Important notice: Please mute the line and microphone channels at the output mixer of the 

soundcard; otherwise you might have positive feedback during measurements. If you use a 

professional audio soundcard, switch off the direct or zero-latency monitoring of the line inputs. 
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4.2.1 WDM Audio Driver Setup 

Microsoft has changed their approach in control of sound devices in Vista / Win7. Now, the operating 

system (also, sometimes in conjunction with control programs of professional soundcards) is 

responsible for setting soundcard native sampling rate and bit resolution.  Operating system changes 

native resolution to floating point format for high quality mixing and eventually for the sample rate 

conversion. 

For LIMP, this means that it is strongly recommended to use ‘Float’ resolution and to set the sampling 

rate to the native format. Access to these values is in ‘Windows sound control panel’, which user 

gets by clicking on the button ‘Control Panel’ in ‘Audio Device Setup’ dialog. 

Fig. 4.7 shows Vista/7 control panel, that has four property pages. 

As first step, user has to adjust 'Playback page' and later repeat the same procedure for 'Recording 

page'. Adjustment steps are: 

1) Click on channel info to choose a playback channel. It is not recommended to use the 

measurement channel as a default audio channel.  

2) Click on button ‘Properties’ to opens channel ‘Sound properties’ dialog. 

3) Click on the tab ‘Levels’ to open the output mixer (as in Fig. 4.8).  Then mute Line In and Mic 

channels, if exist. 

4) Click on the tab ‘Advanced' to set the channel resolution and a sample rate (as in Fig. 4.9) 

5) Repeat previous procedure 1) to 4) for recording channel, and choose the same sampling rate 

as in the playback channel. 

  

 

Figure 4.7 Vista Sound Control panel 
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Figure 4.8 Playback channel properties – Output levels 

 

 

 

Figure 4.9 Setting the native bit resolution and sampling rate in Vista 
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Note: There are a lot of drivers that are not stable under Windows 7. In that case please use ASIO 

driver if it is available for your soundcard. 

4.2.2 ASIO driver setup 

ASIO drivers are decoupled from the operating system control. They have their own control panel to 

adjust native resolution and memory buffer size.  The buffer is used for transferring sampled data from 

the driver to the user program. User opens the ASIO control panel by clicking button ‘Control Panel’ 

in the ‘Audio Device Setup’ dialog. Fig. 4.12 shows an example of ASIO control panel. 

 

 

 

Figure 4.10 E-MU Tracker Pre ASIO Control panel for setting bit-resolution and buffer size 

 

In music applications user usually sets buffer size as small as possible with stable operation. That 

gives the lowest input/output latency (system introduced delay).  

In LIMP, the latency is not problem, as it is encountered in software, but it is not recommended to use 

buffer with size larger than 2048 samples, or smaller than 256 samples. Some ASIO control panels 

express the buffer size in samples, while other express the buffer size in time [ms]. In that case we can 

calculate the size in samples using the following expression: 

 

buffer_size [samples]  = buffer_size[ms] *samplerate[kHz] / number_of_channels. 

 

ARTA automatically sets the buffer size for signal duration of 10 ms (i.e. 512 samples for sample rate 

48kHz, 1024 samples for sample rate 96kHz and 2048 samples for sample rate 192kHz).. 

LIMP always works with two input channels, and two output channels, treating them as a stereo left 

and right channels. As ASIO support multichannel devices, user has to choose in a dialog box 

‘Soundcard Setup’’ which pair of channels will be used (1/2, 3/4, …). 

 

4.3 Generator and Input Monitor Setup 
Three types of excitation signals are possible in LIMP:   

• Sine    

• Multitone 

• Pink PN.  
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User chooses signal type in the top dialog bar or in the dialog box 'Generator and Input Monitor 

Setup' shown in Fig. 4.13. It opens by clicking the menu Setup -> Generator and Input Monitor or 

by clicking the toolbar icon .  Besides signal type, the user can choose other signal characteristics 

(output level relative to maximum level and pink PN cut-off frequency).  

The dialog box also contains a two-channel virtual voltmeter for monitoring voltages on the generator 

output (usually left input channel) and on measured impedance (usually right input channel).  Input 

monitoring has no influence on the measurement of impedance; it just serves to set measurement 

signals to levels that will be treated as small signal or large signal excitation.  

The virtual voltmeter should be calibrated. The calibration steps described below sets the input 

channel sensitivities. We define sensitivity as follows: 

The digital measurement system records sequence of discrete measured values D[i] in a restricted 

dynamic range. In ARTA software, discrete values D[i] are floating point values in the range from -1 

to 1. Virtual measurement system maps internal presentation D[i] to external discrete voltage values 

V[i], that has been recorded, using sensitivity factor: 

Sensitivity = V[i] / D[i],          where |D[i]| <= 1,       i = 0,1,2,…     

The unit of Sensitivity is the Volt as D[i] is dimensionless. The same hold for RMS values of periodic 

signals;  

Sensitivity = Vrms / Drms. 

Maximum possible value of discrete sequence D[i] is 1. That gives us an alternative definition of 

sensitivity as the maximum peak value (or full scale) voltage that can be recorded by digital 

instrumentation; 

 Sensitivity = Vpeak-max (Volts). 
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Figure 4.13 Generator and Input Monitor dialog box 

 

The dialog 'Generator Setup' has following controls: 
 

Generator section 
   Type - chooses the excitation signal: Sine, Multitone or Pink PN  
   Sine freq. (Hz) - enters test frequency of the sine generator  
   Pink cut-off (Hz) - enters the low-frequency cut-off of the pink noise generator  
   Stepped sine level (dB) - chooses the output level (0 to -30 dB) 
   Multisine level (dB) - chooses the output level (0 to -20 dB) for multitone or Pink PN 
  
Input level monitor section 
    Two voltmeter controls - show show either RMS voltages or levels in dBV for left and right input channels 

    dB check box - if checked "LED" controls shows rms voltage in dBV units  
 

Input calibration section 

    Sensitivity (mV peak) - Left - sets sensitivity for Left input channel. 

    Sensitivity (mV peak) - Right - sets sensitivity for Right input channel.     

    Calibrate Left and Right buttons - starts calibration procedure for Left and Right channel. 

  
Start/ Stop button - starts/stops the generator with current settings, also capture signals on both channels 
Ok button closes dialog and saves dialog state. 

Cancel button closes dialog and saves dialog state. 

Peak meter - shows peak value ref. full scale. Meter bars are shown in following colors: 

    Green - for levels below -3 dB,  
    Yellow - for levels between -3 dB and 0 dB,  
    Red - for overloaded input. 
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With LIMP the calibration is simple. It requires that user chooses sine signal and sine frequency in the 

range 300-500 Hz. The circuit for impedance measurement should be connected to the sound card, as 

shown in Fig. 3.1 or 3.2. The process starts by clicking button Start/stop. If recording starts 

successfully we can do calibration by clicking buttons Calibrate Left and Calibrate Right. That 

opens dialog box shown in Fig. 4.14. 

 

 

Figure 4.14 Dialog for calibration of impedance measurement system 

 

Then, user should measure voltage using voltmeter connected instead of measured impedance and 

enter that value in the edit box. The calibration finishes by clicking button ‘OK’. If user click button 

‘Cancel’ the calibration is rejected.  

For usual measurement setup shown in Fig. 3.1 or Fig. 3.2 this procedure will give voltage 

measurement accuracy better than 1%, which is more than enough for monitoring purpose.  

Note: If system uses voltage probe, as in Fig. 3.2, calibration encounters sensitivity scaling 

automatically. Input impedance of voltage probe should be 100 times larger than reference resistor to 

retain accuracy below 1%.  

 

Recommendation:   

• For most reliable results use sine generator, but don't push loudspeaker into large 

displacement (the largest displacement is at frequencies below the loudspeaker resonance 

frequency). Small signal regime requires sine voltages on impedance smaller than 100mV 

rms. 

• For measurements of bass or mid-bass loudspeakers set the Pink cut-off frequency close to 

the loudspeaker resonance frequency (20-100 Hz).  

• If measuring impedance for TSP estimation use low level signals. If you want that estimation 

of TSP using stepped sine mode is comparable to FFT mode lower the sine level 13 -15 dB. 

• Standard AES2-2012 recommends measurement of impedance with 0.1 V rms of sine 

voltage. If we apply multitone or pink with 0.2 V rms we will get comparable results. 
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4.4 Measurement Setup 
For setup of measurement parameters use the 'Measurement setup' dialog box, shown in Fig. 4.15. 

You get it by clicking the menu Setup->Measurement or by clicking the toolbar icon . 

 

 

 

Figure 4.15 Measurement setup 

 

The dialog ' Measurement setup ' has following controls: 

 

In section Measurement config: 
       Reference channel - sets the reference channel  for measuring U1 to Left or Right. 
       Reference resistor - enters the value for the reference resistor. 
  

In section Frequency range: 
       High cut-off - enters measurement upper frequency margin. 
       Low cut-off - enters measurement lower frequency margin. 
       Sampling rate (Hz) - chooses the sampling rate (from 8000 to 96000 Hz). 
  

In section Stepped sine mode: 
Frequency increment - sets to 1/24 or 1/48 octave 
Min. integration time (ms) - enters minimum integration time (higher values give higher noise 

reduction). 
Transient time (ms) - enters transient time to allow the system to get to the steady state (before 

starting the integration). 

Intra burst pause (ms) - enters time needed for system to release the energy from reactive 

components. 

Mute switch-off transients - check box to remove annoying sound due to sine burst abrupt 

switch-off 

 

In section FFT mode (pink noise excitation): 
       FFT size - chooses the length of the FFT block (32768 or 65536). 
       Type - chooses: None, Linear or Exponential averaging. 
       Max. Averages - enters the maximum number of averaging for the 'Linear' mode. 
       Asynchronous averaging - check box to use the asynchronous averaging. 
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4.5 Measurement Procedures 
After you have done the audio device setup, the generator setup and the measurement setup you are 

ready for measurements.    

 

a) Procedure in FFT mode 

Connect loudspeaker in test fixture (Fig. 3.1 or 3.2) and click the menu Record->Start or click the 

toolbar icon  .   Measurements will be periodically repeated and results shown as an impedance 

plot. You will get the graph like one shown in Fig. 4.16.  You can stop the measurements by clicking 

the menu Record->Stop or by clicking the toolbar icon .  

You can copy the graph bitmap by clicking the menu Edit->Copy or by clicking the toolbar icon .  

 

 

Figure 4.16 Impedance measurement without averaging – a noisy measurement 

 

If you set averaging to Linear, measurements will be repeated and averaged until the number of 

averaging reach the predefined value for Max averages  in the 'Measurement setup' dialog box. You 

can stop the averaging at any time by clicking the menu Record->Stop or by clicking the toolbar icon 

. You will get the graph like one shown in Fig. 4.17. 

You can also choose the exponential averaging. It differs from linear averaging in a way that it gives 

more weight to results from last five measurements. 
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Figure 4.17 Impedance measurements with averaging 

 

a) Procedure in Stepped sine mode 

 Measurement procedures for stepped sine mode are almost the same as in FFT mode. The only 

difference is that in FFT mode user will see the impedance plot for full measured frequency range 

almost instantly, while in stepped sine mode procedure will be repeated for many frequencies, step by 

step. The cursor will show current progress in measurements, and that process will be very slow.  

During a measurement, the cursor legend, shown below graph, shows frequency, impedance and THD 

of voltage signal measured on loudspeaker impedance. When the measurement finishes, THD will not 

be shown, but the frequency and maximal value of THD will be saved in a file. You can always see 

that information by clicking menu item ‘File->Info’.  

 

4.6 Graph Setup and Browsing 
The menu command Setup->Graph Setup (or by right-clicking mouse in the plot area), opens the 

'Graph Setup' dialog box, shown in Fig. 4.18. Use this dialog box to adjust the impedance magnitude 

range shown and the frequency range shown. 

 

 

  

Figure 4.18 Graph setup 

 

The 'Graph Setup' dialog box has following controls: 
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Impedance range (ohm) section: 

Graph range - enters the impedance magnitude range. 

Graph bottom - enters the impedance magnitude for graph bottom margin.  

  

Freq. range (Hz) section: 

High – enters the highest frequency shown (in Hz). 

Low – enters the lowest frequency shown (in Hz). 

 

View All – enables the view of all spectrum components that are used in impedance estimation.  

View Phase – enables a phase plot.  

Update – updates the graph with a new setup.  

 

 

    

 

Figure 4.19 Dialog boxes for a graph colors setup 
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Figure 4.20 Standard Windows dialog for color setup 

 

Graph colors can be changed in two ways. The first one is to change the background color from 

"Black" to "White" by clicking the menu command View->B/W color or by clicking the toolbar icon  

. 

The second way to change graph colors is a "user mode". User sets an arbitrary color for every graph 

element using the 'Color Setup' dialog box, shown in Fig. 4.18.  This dialog can be activated by 

clicking the menu Edit->Colors. 

Clicking the left mouse button on colored rectangle opens the standard Windows dialog box 'Color' 

(Fig. 4.19).  Button 'Default' restores default colors.  

A check box 'Use dotted graph grid' enables drawing of grid with dotted line style. 

We can browse the graph by moving the cursor. At the bottom of the graph the label 'Cursor:' denotes 

values of the magnitude and the phase, at the cursor position.  

 

4.7 Calibrated Measurements 
In previously described measurements we have assumed that both soundcard input channels have the 

same sensitivity, but usually it is not true. If the difference in sensitivity of the input channels is larger 

than 0.2 dB, or if soundcard input impedance is small, we need a measurement system calibration.  

4.7.1 Calibration of Input Channels 

LIMP has a built-in calibration procedure. In FFT mode it has to be done for a particular generator 

sequence length and a sampling rate. Stepped sine mode accepts calibration for any sequence length.  

By clicking the menu Record->Calibrate, or by clicking the toolbar icon CAL, we get the 'Calibrate 

Input Channels' dialog box, shown in Fig. 4.21. 

During the calibration procedure measured impedance should be disconnected.   

Calibration will be done for full frequency range using Pink PN signal. 
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Figure 4.21 Dialog for measurement system calibration  

 

In section Generate Pink PN we set the output volume for Pink PN signal which sampling rate and 

sequence length was set in Measurement setup dialog. Clicking the button ‘Generate’ activates the 

signal generation and monitoring of input levels on the Input Level Meter. If necessary, we can adjust 

the output volume by using the combo box 'Output volume'.  

Finally, in section Calibrate we enter the Number of averages (recommended value is 1, as we 

measure high level signals) and click the button ‘Calibrate’. After a second, we have the calibrated 

system.  

Attention: If we change the periodic sequence length (FFT size) or a sampling rate, we have to repeat 

the calibration procedure. 

The last section shows a report of the calibration procedure. If the Channel difference is larger than 3 

dB LIMP gives a warning, and calibration is rejected.  This precaution is required because some 

soundcards change input impedance if gain changes. 

When we click the OK button, the dialog will be closed but the calibration process to be fully 

effective needs one more thing: 

It is recommended that instead of the current value of reference resistor R in measurement 

setup we enter instead the value R || Rin, where Rin is the soundcard passband input impedance, 

which is a real value. This is necessary if we need accuracy better than 1%.  

Note: calibration procedure is changed from LIMP version 1.9.2. In older versions only channel gains 

differences were compensated and measurements were restricted to impedances values up to 200 

ohms.   

To explain how calibration is implemented let’s look at Fig. 4.22. which shows real measurement 

condition. 
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Figure 4.22 Electrical circuit for impedance measurement and system calibration 

 

We assume that voltages are measured using soundcard input channels which have input impedances 

equal to Zin. Reference channel (usually left channel) measures voltage U1. The other channel is 

supposed to measure voltage U2 on measured impedance Z, but value of voltage on Z is a U2, where a   

is the ratio of possible different input channels sensitivities. The generator has output voltage e and 

output impedance Rg, but that values are not important for current discussion.  

The circuit has switch CAL that should be closed during measurement of impedance Z and open 

during the calibration. 

The current through reference resistor R is I = (U1-U2/a)/R.  During impedance measurement 

following equations hold: 

2 / 2
||

1 2

U a U
Z Zin R

I aU U
= =

−
 

here Z || Zin denotes parallel circuit of Z and Zin. It is obvious that even if we have equal gains in both 

channels (a = 1) we measure Z || Zin not the impedance Z alone. 

After some algebraic operation we get expression for impedance Z: 

1

1
1

2

RZin
Z

U a ZinR Zin

U R Zin

=
+

−
+

 

This expression is different from basic impedance measurement expression from chapter 1. It is biased 

with values of gain a and input impedance Zin.  

Now we will define calibration as process which give us the value of factor: a Zin / (R+Zin). 

In calibration procedure we measure voltages U1 and U2, but with measured impedance disconnected. 

From circuit on Fig. 4.21 we get: 

2

1

U cal a Zin

U cal R Zin
=

+
 

This value can be memorized and applied in expression for impedance, which now gets form:   
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Most soundcards input impedance is a real value in the whole audio range (Zin = Rin). If we know the 

value of Rin we can enter in LIMP measurement setup value R || Rin instead of reference resistor R, 

and we will get very accurate measurements. 

Let’s se what will be relative error without accounting for Rin. 

  ( ) / 1
R R Rin Rin

R R
R R Rin R Rin


= − = −

+ +
 

Let Rin = 10k and R = 47 ohms, then relative error is 0.46%. If input impedance is 100k error is 

0.05%.  Practically, even without correction for Rin we will measure with error lower than 1%.  

Note: The measurement impedance range is also limited by input channel noise when we measure 

small and large impedances. If we measure a small impedance, the voltage U2 becomes small. If we 

measure a large impedance, voltage difference U1-U2, that determines current, becomes small. As a 

rule of thumb, we can define measurement range from R/100 to R*100 for most soundcards and signal 

types. If we use high quality soundcards with low noise inputs and stepped sine measurements that 

range can be much larger.  

 

4.7.2 Cable Compensation 

Sometimes we use long cables to connect the loudspeaker to the reference resistance. If we know the 

cable resistance and inductance, then we can enter them in LIMP and substract from measured 

impedance. That procedure, called cable compensation, can be done by menu command Setup-

>Cable Compensation. It opens the dialog box shown in Fig. 4.23. 

 

 

 

 

Figure 4.23 Dialog for cable impedance compensation setup 

 

Two edit boxes are used for entering cable resistance (in ohms) and inductance (in nH). The check box 

"Automatically subtract cable impedance from measured impedance" must be checked if user 

wants that cable compensation be applied during the measurements. 
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4.8 File Manipulations 

Impedance data can be saved in LIMP binary format (.LIM files) and in ASCII format (.TXT or .ZMA 

files).   

Beside impedance data .LIM files can contain user defined text of arbitrary length. The user can enter 

any text in edit box of the File Info dialog box (see Fig. 4.24). This dialog box can be opened by 

clicking menu command 'File->Info'.  

 

  

 

 

Figure 4.24 Dialog for file information 

 

Textual files have extension .txt or .zma. They contain lines of text with three numeric literals: 

frequency (in Hz), magnitude (in ohms) and phase (in degrees). The line ends with new line character.  

The only difference between .txt and .zma files is that .txt files can contain comment lines. Comment 

lines start, after arbitrary number of space or tab characters, with nonnumeric characters, while data 

lines start with digit or dot character. 

The file can be loaded as regular impedance data or as data for the overlay plot . Only one overlay is 

followed. 

Binary file .LIM format is as follows:  

char id[4];              // four characters id {'L','I','M','\0'}; 

unsigned version;        // version number - started from 0x0101 

unsigned reserved;       // 0    

int numdata;             // number of data points 

int cursorpos;           // last position of cursor 

int fftlen;              // length of FFT in FFT mode 

float fs;                // sampling frequency 

float data[3*numdata]    // contains  frequency, magnitude and phase 

int infolength;          // info string length 

char string[infolength]; // info string data 
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5 Loudspeaker Parameters 
 

This chapter gives some definitions and measurement procedures for the estimation of loudspeaker 

parameters. 

 

5.1 Definition of Physical and Dynamical Loudspeaker Parameters 
 

An electrodynamic loudspeaker that is unbaffled in free air or mounted in an infinite baffle is 

characterized by the following physical parameters: 

 

Electromagnetic parameters: 

RE  - voice coil DC resistance () 

ZLE  - impedance of voice coil inductance and coupling to the pole piece () 

Bl  - force factor (Tm)  

 

Equivalent circuits used to characterize the impedance ZLE are shown in Fig. 5.1c, and denoted as: L2R 

[10], [11], L3R [7], and L2RK [12], [13]. 

 

Mechanical parameters: 

S  - effective area of membrane (m2)   

CMS  - membrane mechanical compliance (m/N) 

MMS  - mechanical mass of membrane MMD plus mass of air load on membrane MMA (kg)  

RMS  - mechanical resistance plus membrane radiation resistance (kg/s) 

 

For the unbaffled driver the membrane air load mass is MMA = 0.5658 S3/2, which is half of the air load 

mass in an infinite baffle.  

The membrane effective area S, also called piston area, is normally obtained from a cone diameter 

measurement that includes 1/2 of the surround width [6], [11]. This value is good estimation for S if 

motion of surround is linear, but in practice it can vary. Program MLSSA [10] suggests diameter value 

that include only 1/3 of the surround width.  

Fig. 5.1 shows wideband and low-frequency equivalent circuits of an electro-dynamic loudspeaker that 

is mounted in a free air unbaffled or in an infinite baffle. The circuit for definition of low-frequency 

input impedance uses the following elements:  

 

( ) ( ) ( )222
/,/, BlMCRBlRCBlL MSMESMSESMSCES ===  
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Figure 5.1 a) Wideband analogous circuit of an electro-dynamic loudspeaker that is unbaffled or 

mounted in an infinite baffle, b) circuit for the estimation of the low- frequency input impedance, and 

c) three circuit models for lossy inductor ZLE (L2R, L3R and L2RK model) 

 

Using these analogous circuit elements, Thiele and Small ([6], [7]) introduced dynamical loudspeaker 

parameters. They are defined in the Table 5.1. 
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Equivalent acoustical volume (m3) 
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Table 5.1 Thiele-Small dynamical loudspeaker parameters ( 0 = 1.18kg/m3, c = 345m/s, pref = 20Pa) 
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Thiele and Small have shown that by using these parameters it is easy to express the low-frequency 

response of a closed loudspeaker box as 2nd order high-pass filter and response of bass-reflex box as 

4th order high-pass filter. Today, almost every loudspeaker manufacturer provides physical and Thiele-

Small parameters in their loudspeaker data sheets. 

An old industry standard assumed that the voice coil electrical impedance contains resistive (RE) and 

pure inductive (ZLE = jLE) components. Voice coil inductance (LE) was usually specified as inductive 

component of driver impedance at 1 kHz. In modern instrumentation that model is abandoned, and the 

voice coil is treated as “lossy” inductor whose impedance ZLE depends on frequency. Physically, ZLE 

represents the input impedance of the "transformer" whose secondary winding is the pole piece. Eddy 

currents in the pole piece give rise to primary circuit resistance.  

The simplest model [8] for a primary input impedance is Kj = K (1+j) /2, where K is constant. It 

is expressed in unit called semiHenry (sH).  The impedance of such semi-inductance increases with 

 rather than . This model is not practical as engineers in many numerical simulations use some 

form of an equivalent electrical circuit that closely matches measurement data.  

The most commonly used equivalent circuit for the electrical voice coil impedance in modern 

instrumentation ([10], [11]) is serial connection of resistor RE, inductor LE and parallel connection of 

resistor R2 and inductor L2. It is denoted in Fig. 5.1 as L2R model. For many years it has been proven 

as useful model in many simulations.  

LIMP also enables estimation of two additional and more accurate equivalent circuits for lossy 

inductor: L3R and L2RK models. They are also shown in Fig. 5.1. The L3R model extends L2R 

model with one more parallel circuit L3||R3, while in L2RK model, as defined by Thorborg [12], a semi 

inductance K is added parallel to circuit L2||R2.  

Originally, Small [6] defined parameters for loudspeaker mounted in an infinite baffle, but he allowed 

the same expression to be used for unbaffled loudspeaker. The same is allowed by the IEC 60268-5 

standard [15], with requirement to report which type of mounting is used in measurements. Instead od 

using an infinite baffle, the IEC standard requires the use of a baffle of dimension 135x165 cm with 

driver mounting hole offsets from center 15x22.5cm. Standard AES2-2012 [16] exclusively advocates 

measurements with unbaffled driver. LIMP procedures support both type of driver mounting. 

Thiele-Small parameters can be used to measure and analyze the response of a loudspeaker mounted in 

a closed box. The analogous circuit have the same elements as circuit on fig. 5.1., but values of 

elements change: CMS is replaced with parallel connection of CMS and equivalent box volume 

compliance, MMS changes in air load mass term, and RM changes due to added dissipation inside the 

box. The air load mass of loudspeaker mounted in closed box is between values for unbaffled driver 

and driver mounted in infinity baffle. This is probably the main reason why both types of mounting are 

accepted in practice - both are equally accurate and valuable to predict box response sensitivity and 

efficiency. 

 

5.2 Theory for the Estimation of Loudspeaker Parameters 
 

For the estimation of Thiele-Small parameters (TSP), LIMP offers two methods:  

1) Thiele-Small method and  

2)  Nonlinear Least Square Error (LSE) minimization method.  

LIMP also uses LSE minimization for estimation of lossy inductor equivalent circuit elements.  It is a 

first step in TSP estimation because it helps to remove influence of inductance element from analog 

circuit before using it in TSP estimation. 
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5.2.1 Estimation of Lossy Inductor Equivalent Circuit Elements 

LIMP estimates the values of lossy inductor equivalent circuit elements as values that give the least 

sum of squared differences between lossy inductor impedance ZLE(f) and a measured input impedance 

ZM(f) over all frequencies that are above the frequency of minimum of impedance. LSE error function 

is defined as: 

  −−=
f

LELFM fZfZfZ
2

)()()(  

where ZLF(f) is a low frequency loudspeaker impedance estimated by Thiele-Small method (which is 

described in the next Section).   

By default, LIMP estimates elements of L2R model by stable, linearized LSE error minimization 

method – sometimes also called a linear regression method. In addition, user can choose more accurate 

nonlinear LSE minimization methods for L2R, L3R and L2RK model circuit elements. For full 

discussion of these and TSP estimation methods it is recommended to read the paper [13]. 

 

5.2.2 Thiele-Small Method for the Estimation of TSP 

It is easy to estimate Thiele-Small parameters if we have measured data for the loudspeaker impedance.  

The voice coil resistance RE should be measured with a DC ohmmeter. 

At low frequencies the influence of a voice coil inductance and eddy currents is small and an 

expression for the loudspeaker input impedance has the following form:  

 

 
)/()/1(

)/()/1(
)(

22

22

MSSS

TSS
ELF

Qffjff

Qffjff
RZfZ

+−

+−
=    

The impedance has maximum value at the resonance frequency:  

                                       ( ) ESETESES RRQQRffZZ +==== /max             as QES >QT.    

 

 

Figure 5.2 Typical impedance curve of a loudspeaker that is mounted in free air 

 

At frequencies f1 and f2, (where f1<fS<f2, and  f1 f2 = fS
2) impedance values are of equal magnitude;   

 ( ) ( ) 2
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If we substitute this expression in the expression for the input impedance, we get:  
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From this equation we get the mechanical Q-factor:  
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Now we can define a step-by-step procedure for the measurement of Q factors: 

1. Measure a voice coil resistance RE with a dc ohm-meter 

2. From impedance curve find fS and Zmax. Define ro=Zmax/RE. 

3. Choose some impedance magnitude RE<|Z1|<Zmax and find both frequencies (f1 and f2) where Z = 

Z1.  Then define r1=Z1/RE. 

4. Calculate QMS from the above equation,  

5. Calculate QES using the equation QES=QMS / (ro-1).  

6. Calculate QT using the equation QT=QESQMS / (QES+QMS).  

 

This procedure gives good results under two conditions:  

1. if we have low noise level in measurement of impedance, and  

2. if we first subtract magnitude of lossy inductor impedance |ZLE| from the magnitude curve. In 

first iteration |ZLE| is unknown. In that case TSP estimation procedure uses values of Z1 and f1 

from measured magnitude curve that are below the resonance frequency fS and sets 1
2

2 / fff s= .   

If we have noisy measurements, we can reduce the estimation error by repeating Thiele-Small 

procedure for different frequencies and average value of QMS. Good choices are frequencies where 

magnitude is 20% lower than maximum magnitude and 20% larger than minimum magnitude.  

These two simple modifications of standard Thiele-Small procedure give accurate and reliable 

estimation of TSP. 

5.2.3 Nonlinear LSE Minimization Method for the Estimation of TSP 

The Thiele Small procedure is realizable only if the value of RE is known, but sometimes that value is 

not known. In that case we can use the nonlinear LSE minimization procedure where we minimize 

squared difference between measured impedance ZM and model impedance ZLF, i.e. we define LSE 

function as: 

  −−=
f

LFLEM fZfZfZ
2

)()()(  

where optimization variables are RE, fS, QMS and QT. ZLE(f) is impedance of lossy inductor that is also 

estimated by LSE minimization. 

If the value of RE is known, optimization variables are: fS, QMS and QT.   

In some rare cases a convergent LSE minimization cannot be realized. In that case the modified 

standard Thiele-Small procedure would be used. 
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5.3 Estimation of Physical Loudspeaker Parameters 
 

Three methods will be used for the estimation of physical parameters MMS, CMS, RMS and Bl; 

1. Added mass method, 

2. Closed box method, 

3. Fixed mass method. 

All these methods can be used for measurement of a loudspeaker mounted in an infinite baffle or in 

free air. The results for two mountings will differ slightly as air load mass is not the same. The air load 

in a large baffle is two times larger than in free air. Although results will differ slightly we argue that 

they can be successfully used in box design.  

There are two standards that define measurement of physical loudspeaker parameters. IEC 60268-5 

[15] defines closed box method. The other standard AES2-2012 [16] extends IEC standard with added 

mass method. AES2-2012 also specifies that mounting should be done with firm clamp in vertical 

position so that gravitational force does not offset membrane.  

For estimation of physical parameters LIMP uses and improves methods promoted by Small [6] and 

measurement system MLSSA. They are described in next sections. 

5.3.1 Added Mass Method 

In this method, we first measure the impedance curve and estimate Thiele-Small parameters fS, QMS 

and QES, for the loudspeaker mounted in free air. Then we put an additional mass (Madded) on the 

membrane, measure impedance curve and estimate the shifted resonance frequency fM and electrical 

Q-factor QEM. From equations for QEM and QES, we get Bl2. By equating both expression for Bl2, as 

we assume it to be constant in both measurements, we get: 
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When we know MMS and fS, it is easy to get the mechanical compliance CMS, resistance RMS and force 

factor Bl. By using equations that are defined in Table 5.1 we get 
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This method is used in LIMP by default. It is called “constant Bl” method. Standard AES2-2012 uses 

“constant compliance” method, where expression for CMS with and without added mass are equated to 

get: 
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In most cases assumption of constant compliance gives worse results than “constant Bl” solution. Why? 

In low frequency region membrane has large displacement which generates nonlinear behavior of 

compliance and force factor Bl, but compliance also has rise toward low frequencies due to 

viscoelastic creep effect. In both cases it is important to measure impedance with small signal 

excitation. 

   

5.3.2 Closed Box Method 

In this method we first measure the impedance curve and estimate Thiele-Small parameters fS, QMS and 

QES, for the loudspeaker mounted in free air. Then we mount the loudspeaker in a closed box, of 

known volume VB, measure impedance curve and estimate Thiele-Small parameters fC, QMC, and QEC. 

From these we find [6]: 
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Then, by using equations that are defined in Table 5.1, we get: 
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The problem of  measurement piston area S 

The accuracy of estimation of physical parameters depends on the value of membrane area S. The 

value is normally obtained from a cone diameter measurement that includes 1/3 - 1/2 of the surround 

width. MLSSA [10] suggests a method to estimate area S from measurement data. The method is 

based on applying two measurement methods; added mass and closed box, successively to the same 

driver. This technique makes use of the fact that VAS is independent of S for the closed-box method 

while MMS is independent of S for the added-mass method. Then the value of area S in square 

centimeters can be computed as, 

2
2

2
( ) 10 0.1677MS AS S
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M V
S cm f M V

c




= =  

where MMS in grams is measured using the added-mass method while VAS in liters is measured using 

the closed-box method. Frequency fS is driver resonant frequency that is measured without box. 

 

5.3.3 Fixed Mass Method 

The fixed mass method assumes that we have unassembled driver membrane of area S. The static 

weight of membrane MM (including voice coil and half of suspension and spider) is measured 

statically. 

Total dynamical mass MMS is obtained by adding air loading mass. If driver is unbaffled the total mass 

is calculated by the expression: 

MMS = MM + 0.5658 S3/2 

If loudspeaker is mounted in IEC or larger baffle the air load mass should be doubled. 

In this method we first measure the impedance curve and estimate Thiel-Small parameters fS, QMS and 

QES, for the loudspeaker mounted in free air or in IB, then by using known value of MMS, we get:  
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This method is most accurate, and simplest as we need only one impedance measurement.  

 

5.4 Automatic Estimation of Physical and Dynamical Loudspeaker 
Parameters 
 

LIMP procedures for the estimation of basic loudspeaker parameters are as follows. 

To estimate Q-factors of a loudspeaker we need:  

 

1. measured impedance data (without any overlay curve),   

2. measured voice coil dc resistance (in ohms), 

3. estimated membrane diameter in cm. 

 

By clicking the menu ‘Analyze->Loudspeaker parameters – Added mass method’, we get the 

'Loudspeaker Parameters - Added Mass Method ' dialog box, shown in Fig. 5.3.  

 

 

Figure 5.3 Dialog box for the estimation of loudspeaker Q-factors 
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In this dialog box, user enters values for Voice coil resistance and Membrane diameter in 

appropriate edit boxes. Click on button ‘Calculate’ gets the report shown in the left edit box. This 

report can be pasted to the clipboard by pressing the button ‘Copy’. The click on button Export saves 

data in file using the Excel .csv format. 

In the section "Nonlinear LSE Optimization" user sets three check boxes to allow more accurate 

nonlinear LSE optimizations: 

Estimate TSP by LSE minimization   

Estimate voice coil resistance (if voice coil resistance is unavailable) 

Estimate lossy inductor model 

To apply LSE method, impedance measurement should be done in full frequency range (20 kHz), or at 

least to frequency that is a hundred times larger than loudspeaker resonance frequency. 

 

5.4.1 Added Mass Method 

To estimate all physical and dynamical loudspeaker parameters we must make two impedance 

measurements of the loudspeaker impedance in a free air. In one of the two measurements, the 

membrane must be loaded with an additional mass. This is what we need: 

1. measured impedance data,  

2. impedance data measured with an additional mass set on the membrane (as in Fig. 5.4),  

3. one of the curves (1 or 2) must be set as an overlay graph,  

4. measured additional mass - in grams, 

5. measured voice coil dc resistance - in ohms, 

6. diameter of the membrane - in cm, 

 

Figure 5.4 Impedance curves (the one with lower resonance frequency is obtained by adding mass to 

the membrane) 
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Then we click the menu item Analyze->Loudspeaker parameters – Added mass method to get the 

'Loudspeaker Parameters – Added Mass Method' dialog box, shown in Fig. 5.5.  

 

 

Figure 5.5 Dialog box for the estimation of loudspeaker parameters using Added Mass Method 

 

User enters values for Voice coil resistance, Membrane diameter and Added mass in appropriate 

edit boxes. Click on the button 'Calculate parameters' gets the report shown in the left edit box. This 

report can be pasted to the clipboard by pressing the button 'Copy'. The click on button Export saves 

data in file using the Excel .csv format. 

Check box 'Driver mounted in infinite baffle' sets condition of measurement. Here it is empty which 

means that driver is unbaffled.  

Check box 'Use constant compliance method' enables alternate equation to estimate physical 

parameters. The default is "constant Bl" method. 

In the section "Nonlinear LSE Optimization" user sets three check boxes to allow more accurate 

nonlinear LSE minimization. 

Estimate TSP by LSE minimization   

Estimate voice coil resistance (if voice coil resistance is unavailable) 

Estimate lossy inductor model 

Three lossy inductor circuits:  

Le+L2||R2  

Le+L2||R2+ L3||R2  

Le+L2||R2||K 

are selectable by using the list box at the bottom of this section (+ denotes serial connection, || denotes 

parallel connection). 
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5.4.2 Closed Box Method 

To estimate all loudspeaker parameters, we must have two impedance measurements. In one of the 

measurements the loudspeaker must be mounted in a closed box of known volume. That is what we 

need: 

1. measured impedance data,  

2. impedance data measured with loudspeaker mounted in a closed box,  

3. one of the curves (1 or 2) must be set as an overlay graph (as in Fig. 5.7),  

4. measured value of the box volume - in liters, 

5. measured voice coil dc resistance - in ohms, 

6. diameter of the membrane - in cm, 

 

Then we click the menu item Analyze->Loudspeaker parameters – Closed box method to get the 

'Loudspeaker parameters – Closed Box Method' dialog box, shown in Fig. 5.6.  

 

 

Figure 5.6 Dialog for the estimation of loudspeaker parameters using Closed Box Method 

 

Finally, we enter values for Voice coil resistance, Membrane diameter and Closed box volume in 

appropriate edit boxes. Press on the button 'Calculate' gets the report shown in the left edit box. This 

report can be pasted to the clipboard by pressing the button 'Copy'. The click on button Export saves 

data in file using the Excel .csv format. 

In the section "Nonlinear LSE Optimization" the user sets three check boxes to allow more accurate 

nonlinear LSE minimization: 
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Estimate TSP by LSE minimization   

Estimate voice coil resistance (if voice coil resistance is unavailable) 

Estimate lossy inductor model 

 

Three lossy inductor circuits:  

Le+L2||R2 

Le+L2||R2+ L3||R2 

Le+L2||R2||K 

 

are selectable by using the list box at the bottom of this section (+ denotes serial connection, || denotes 

parallel connection). 

5.4.3 Fixed Mass Method 

In this method we use single impedance measurement. The loudspeaker is unbaffled or in infinite 

baffle    

This is what we need: 

1. measured impedance data,  

2. measured static mass of membrane with voice coil and half of suspension and spider. 

3. measured voice coil dc resistance in ohms, 

4. estimated membrane diameter - in cm 

 

Then we click the menu Analyze->Loudspeaker parameters - Fixed mass method to get the 

'Loudspeaker parameters - Fixed Mass Method' dialog box, shown in Fig. 5.7.  

 

 

Figure 5.7 Dialog for the estimation of loudspeaker parameters using Fixed Mass Method 
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User enters values for Voice coil resistance, Membrane diameter and Static membrane mass in 

appropriate edit boxes. Click on the button 'Calculate parameters' gets the report shown in the left 

edit box. This report can be pasted to the clipboard by pressing the button 'Copy'. The click on button 

Export saves data in file using the Excel .csv format. 

In this dialog the check box 'Driver mounted in infinite baffle' is not for informative purpose only, 

like in previous cases. Here it determines the proper value of air load mass shall be used in 

calculations of MMS. 

 

5.4.3 Monitoring the Quality of Loudspeaker Parameters Estimation 

LIMP doesn't show any "single number" indicator of TSP estimation quality, but the user can visually 

check the quality of estimation – by pressing the F3 key in measurement window, or by menu 

command Overlay->Make target curve from TSP. It will generate impedance curve from currently 

calculated loudspeaker parameters and show it as target curve.  

The quality of Loudspeaker parameter estimation is not high. The estimation of Vas and MMS can show 

differences, depending on method used in the range 20-30%. Here is partial explanation of these 

differences, and where they came from.  

The Thiele-Small model is a simplified linear model, while the loudspeaker is a highly nonlinear 

device. The nonlinearity is largest below resonance frequency where the loudspeaker membrane has 

largest displacement. It causes nonlinearity in compliance and force factor Bl. The compliance is also 

changing as a function of frequency – that is called a creep effect, and it makes larger compliance 

variation in the added mass method than in the closed box method. The closed box measurement 

method is very often disturbed by large air leakage. Compliance is also a function of temperature. 

Loudspeaker that are used in cars are exposed to large temperature variations, and in extreme cases 

compliance can change more than 50%.    

The Fixed mass method can give best results, as it is less dependent on compliance shift, but in many 

cases, it is impossible to have unassembled driver membrane. 

For proper measurement it is extremely important that a loudspeaker passes a long burn-in period, as it 

helps stabilize suspension dynamics. Burn-in could be done with music signals with high low-

frequency content or with ARTA test signals (pink noise or multitone).  
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6 RLC Measurement 

 

LIMP can be used to measure value of resistors, capacitors and inductors, simply by calculating 

resistive, inductive or capacitive parts of the measured impedance. For example, Fig. 6.1 shows 

impedance curves of an capacitor with nominal value of 6.9 uF. 

  

 

    Figure 6.1 The impedance graph of a 6.9 uF capacitor 

  

By clicking menu command Analysis->RLC Impedance value at cursor position we get the dialog 

box with report as shown on Figure 6.2. Here LIMP reports that measured impedance has resistive part 

of 0.587 ohms and imaginary part is capacitive with value of 6.93 uF.  
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    Figure 6.2 Impedance of  6.9 uF capacitor 

  

LIMP measures the inductance in the same way. The report of measured impedance is shown in Fig. 

6.2. The last line shows the value of dissipation factor D. It is equal to the ratio of impedance real and 

imaginary parts at specified frequency. The reciprocal value of D is called quality factor Q. It is 

normally used to show the quality of inductors. 
  
Note: These measurements can be confusing if impedance phase is close to zero degree or very 
close to -90 or +90 degrees. A very small error in measurement can results with false capacitive or 
inductive values.    

 

6.1 Importance of Calibration 

When measuring impedance and capacitance it is very important to calibrate the system 

before the measurement. Why? 

Even if there is a very small difference between channel sensitivities (i.e. 0.1 dB), LIMP can 

give erroneous result, because inductor impedance has phase close to plus 90 degrees, and 

capacitor impedance has phase close to minus 90 degrees. In that case if there is a difference 

in sensitivity of measured generator voltage V1 and impedance voltage V2 (if sensitivity of 

probe V2 is larger than sensitivity of probe V1) estimated impedance gives phase values that 

are larger than 90 degrees and the graph shows warped jump in the phase for 180 degrees. 

Figure 6.3 shows the case of measuring a capacitor without the calibration. In half the range 

the phase is close to plus 90 degrees, and suggests that we are dealing with an inductance.  

Figure 6.4 shows capacitor impedance after the calibration. We see correct values for phase in 

the whole frequency range. 
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Figure 6.3 Wrongly estimated impedance of plastic capacitor 4.7 uF/250V (measured without 

the calibration)  

 

 

Figure 6.4 Correctly estimated impedance of plastic capacitor 4.7 uF/250V (measured after 

the calibration)  
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